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Release Notes
This document covers pertinent information, including Known Issues and Resolved Known Issues, for Q-Sys
Designer Release 2.1, September 2011.

Important
As with any upgrade, be sure to create backup files for any designs you have.

If you are upgrading a system from Q-Sys Designer 1.2 to 2.1 the followingmay apply to your system.

l If you have defined User accounts in release 1.2, youmust recreate the Users using the Q-Sys Design
Administrator. This includes assigning the new User accounts for UCIs (User Control Interfaces).

l Youmust recreate any scheduled events, using the Q-Sys Design Administrator.

l If you have created any UCI panels and displayed them with Adobe AIR, you can now use theWindows UCI
viewer. Adobe AIR no longer works with Q-Sys UCIs.

l When you upgrade to version 2.1 the Core's storage drive is re-partitioned. The installation process copies any
media files stored on the Core's hard drive to your PC. The process then copies the files back to the Core's
hard drive. Prior to copying the files, the installation program checks the available space on the Core's hard
drive. If there is not enough space for the new partition and themedia files, you will receive a warning that your
media files will be lost, with an option to cancel. If you do not have a backup of your media files, contact Q-Sys
Support before starting the upgrade.

Installation Software Requirements

Software Package Q-Sys Designer

Microsoft Windows XP Professional Version 2002 SP3
(32 bit) or
Microsoft Windows Vista SP1 (32 bit) or
Microsoft Windows 7 (32 or 64 bit)

Prerequisite

Microsoft .NET Framework 3.5 SP1
Prerequisite
The installation program automatically installs the
required files. 1

Apple Bonjour forWindows

This is required only if you are upgrading from Q-Sys
Designer release 1.0 or 1.1 to release 1.2. If you are
upgrading from 1.0, or 1.1, to version 2.1, youmust
upgrade to 1.2 first. Bonjour does not work with Q-Sys
release 2.1.
User must obtain and install

1. Internet access required.
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Q-Sys Designer / Design File Compatibility
Q-Sys Designer release numbering convention is a three-level system –major release.minor release.build number
(2.1.430). Larger numbers indicate a newer the release. If the "major.minor” release number of a design file andQ-
Sys Designer software are the same, the "build" number doesn't matter. Youmay have to upgrade/downgrade your
hardware to the same "build" number as the Q-Sys Designer software to Run the design on the Core.

You cannot open a design file with a newer "major.minor" release number than the Q-Sys Designer software. For
example, you cannot open a 2.1.nnn design file with 2.0.nnnQ-Sys Designer software.

You can open a design file with an older "major.minor" release number than the Q-Sys Designer software. For
example, you can open a 2.0.nnn design file with 2.1.nnnQ-Sys Designer software. If you save the file with the
newer software, you cannot save it back to an older release.

IMPORTANT: Make sure your design files are backed up in your current release before starting the upgrade to a
newer release.

NewHardware in Q-Sys
l CobraNetCard (BETA) – Adds CobraNet capability to Q-Sys. You can install the card in the Core or

an I/O Frame.

l Standard Mic/Line InCard (BETA) – Provides a lower cost solution for mic/ line input scenarios.

l TSC-8 Touch Screen Controller – The TSC-8 series products are network enabled, 8.4-inch, capacitive
touch-screen control panels. You can create User Control Interfaces (UCI) in Q-Sys Designer for use
with the TSC-8.

Type 2 Hardware
Type 2 hardware provides new cables and connectors between the I/O cards andmain boards, replacing those
installed in earlier releases of hardware. Due to this change, the Type 2 hardware is not physically compatible with
the older hardware. You can still integrate the new I/O Frames and Cores in the same system with older hardware,
but the I/O cards are not interchangeable. Type 2 hardware can be identified by a yellow label on the back of the
Core and I/O Frame, and the bottom of the I/O cards.

NewComponents in Q-Sys Designer
Please read the following information carefully. There aremany changes and additions for Q-Sys Designer 2.1, some
requiring your attention when you upgrade your Q-Sys Designer installation to this release. As with any upgrade
containingmajor changes, theremay be a substantial impact to your current designs. Before you upgrade be sure
you understand the changes that are required for your system, and be sure you have backed up your design files.

Control

Event Log Component
The Event Log component displays the last item added to the event log. The information displayed is: date/time,
severity, category, andmessage. You can use the Event log to send this information to a Lua Script. For the
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complete Event Log, refer to the Q-Sys AdministratorEvent Log topic.

Effects

Auto-Pan Component (BETA)
The Auto-Pan Component allows you to take amono signal and automatically pan it between the channels of a
stereo output, or a stereo input and pan the channels automatically between the stereo output channels.

Chorus Component (BETA)
The Chorus Component mixes two identical signals, with one of the signals delayed by a small, slowly
modulated amount.

Echo Component (BETA)
The Echo Component enables you to create a delay or echo effect for mono or stereo inputs and outputs.

Flanger Component (BETA)
The Flanger Component mixes two identical signals, with one of the signals delayed by a small, slowly
modulated amount.

Tremolo Component (BETA)
The Tremolo Component allows you tomodulate the gain of amono input to get amono or stereo output, or a
stereo input to a stereo output.

Inventory

CobraNet (BETA)
The CobraNet card is represented in Q-Sys Designer by two components that you can add to your design; the
CobraNet In Component, and the CobraNet Out Component. Youmay install up to four CobraNet cards in an I/O
Frame, and one in a Core. The CobraNet card (BETA) gives you four input and four output channels of CobraNet
digital audio.

RS-232 Serial Port
There is an RS-232 Serial Port, on the rear panels of the Core and I/O Frames. The representative RS-232 Serial
Port Component is automatically in the Q-Sys Designer Inventory list as part of the Core, and any I/O Frames you
add to the Inventory. When you add the component to your design, and connect it to the Control Script Component,
you establish a connection to the RS-232 connector on a Core or I/O Frame. You can now write an appropriate Lua
Script to control and read from devices such as DVD players, recording hardware, video, lighting, and so on.

Changed Components in Q-Sys Designer
Acoustic Design Loudspeaker Components
The 8-Ohm Bypass option in the Properties is now Low Impedance. This change affects the following
loudspeakers: AD-S282HT, AD-S52T, AD-S82, AD-S82H, AD-S32T, AD-S28Tw.
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Audio Player Component
Playlists, created in Q-Sys Administrator > Audio Files, are available for selection in the Audio Player. You can
select to Repeat the list, shuffle the list, or play in the file order of the Playlist. In Shuffle mode, if Repeat is on, Q-
Sys re-shuffles the list, and plays it again.

Channel Group Component
You can now copy Channel Group channel Select buttons into the Schematic, or a UCI.

Custom Controls Component
A new control type, Status Display, is available for selection as a Custom Control.

Delay Component
There are three types of Delays available in the Delay Component: Standard, Fractional, and Crossfaded.

l The Standard Delay rounds the Delay time to the nearest whole number of samples, and ramps the signal level
down to -20 dB then ramps back to the original signal level but at the new delay time.

l The Crossfaded Delay rounds the Delay time to the nearest whole number of samples, andmaintains two
delay lines for each tap. When the Delay time changes, one of the delay lines is updated with the new delay
time, the other uses the original delay time. The output signal changes to the new time by cross-fading from the
original Delay time to the new Delay time.

l The Fractional Delay interpolates the audio signal between samples if the Delay time is not equal to a whole
number of samples, and ramps the Delay time to the new Delay time. The signal level is not changed.

The Delay Component now has a Linear Gain option, in the Properties, in support of acoustic positioning control.

Delay Matrix Mixer Component
The Delay Matrix Mixer now has the option, in the Properties, to select the Type of delay. The choices are
Standard, Crossfaded, and Fractional.

The Delay Matrix Mixer component now has a Linear Gain option, in the Properties, in support of acoustic
positioning control.

Dynamics Components
The following change applies to the Automatic Gain Control, Compressor, Expander, Gate, Peak Limiter, and
Priority Ducker Components.

In Gain is applied to both themain Input and the Side Chain input, regardless of whether the Side Chain Input
Property is No (internally connected) to themain Input, or Yes (externally connected) to themain Input. In earlier
releases, when you bypassed the Component, In Gain was not available at themain Input and the Side Chain
input. This could cause a Side Chain signal level shift that wouldmake it difficult to adjust the Component while
bypassed. In this release, Q-Sys Designer always applies In Gain to the Side Chain input signal, regardless of the
state of Bypass.
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There is a new Property, Bypass GainMeter, to determine if the Applied GainMeter is active or not. When set to
Active, the Applied Gainmeter is active regardless of the state of the Bypass button. This means you can adjust
the dynamics processor in Bypass mode. When set to Inactive, the Applied Gainmeter is inactive to give you an
indication that the component is in Bypass mode.

This change applies to all Dynamics components. When the Bypass button is active, the word BYPASSED
displays in themiddle of the ResponseGraph.

EQ Components
This change applies to all Equalizer and Filter Components with the exception of the FIR Custom Filter. When the
Bypass button is active, the word BYPASSED displays in themiddle of the ResponseGraph.

E-mailer Component
The E-mailer Component now works with SSL email accounts. Examples of email accounts requiring SSL are G-
mail, Hotmail, Yahoo, etc.

Generic Loudspeakers Component
The name of the Generic Distributed Speaker has been changed to Generic 25/70/100V Speaker.

GPIO Component (Core and I/O Frame)
TheWCP-2Wall Control Panel now uses only three pins of the GPIO connector instead of four. When you select
theWCP-2 onGPIO Pin 1, it uses pins 1, 2, and 3. When you select it on GPIO Pin 5, it uses pins 5, 6, and 7. This
makes pins 4 and 8 available for other use.

Hardware Components
Verbose details in the Core Status, I/O Frame Status, Page Stations, Q-LAN Transmitter and Receiver
components, only display when the value is not zero.

A combination ID/LED button in the Status components of the Core, I/O Frame, and TSC-8 has replaced the ID
button and Identification LED. The same change applies to the Q-Sys Configurator for these components. In
addition, when you activate the ID/LED button, it flashes for 5minutes, and then stops unless you stop it prior to
that by pressing it or clicking it again.

Loudspeaker Components
Line Arrays, Acoustic Design, Subwoofers, Generic Speaker, Generic 25/70/100V Speaker

WhenQ-Sys detects an amplifier attenuator at -20 dB (20 dB below full output) or below, Pilot Tones and
Impedance readings are disabled. In addition, if you enable Pilot Tones when the amplifier attenuator is turned to -
20dB or below, the loudspeaker Status will indicate a compromised state.

When aQSC Amplifier is in Standby, the Loudspeaker Status field indicates this condition.

PA Router Component
The PA Router has two new buttons: Cancel All Commands, and Cancel Queued Commands Only
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Parametric EQ Component
High- and Low-shelf options are now available in the Parametric Equalizer Component.

Responsalyzer Component
The following Control Pins are now available for the Responsalyzer: Clear, Coherence, Impulse Response,
Magnitude Response, Phase Response, RTA, and Update. The intention of the Control Pins is for use
in Lua Scripts.

Router Component
The Router Component Properties has a new choice under Selection Controls called Output Select Mode. When
you choose theOutput Select Mode, the Control Panel displays anOutput selector knob and aMute button for
each Input, as opposed to Input selectors for eachOutput.

Themaximum limit for Input andOutput Count, for Crosspoint and Combo Box controls has been raised from 4096
(64 Inputs * 64Outputs) to 16384 (128 Inputs * 128Outputs). For Input/Output counts above this, up tomaximum
of 512/512, the Knob control is available.

Snapshot Controller Component
TheMatch and Last LEDs are no longer available on the Snapshot Controller Component. Now, a color change on
the Load button indicates the following states: off – dark green, modified – dim green, and loaded – bright green.

System Mute Component
SystemMute control state is now remembered on the Core when you deploy the same design back to the Core,
and in Emulatemode and then to RunMode when you deploy a new design to the Core.

User Control Interface
The UCI design now supports navigation buttons. When you havemultiple pages, and do not want to use Tabs,
you can drag a page from Q-Sys Designer's left-side pane onto the page displayed in the design interface. Doing so
creates a navigation button for the page you dragged in. You can also use the PolygonGraphic tool to draw a shape
and assign it a page by dragging the page from the left-side pain into the Polygon shape.

You can now re-order the pages of a UCI by dragging them to a new position in the left-side pane. When you
reposition a page in the left-side pane, the pages are re-ordered in the UCI display as well.

When you add graphics to a UCI, Q-Sys Designer scales the images down based on the Panel Type as set in the
Properties of the UCI. The images are never scaled up.

Virtual Page Station Component
The Virtual Page Station Component is effectively a new component. Designed for use on a touch screen, the new
Virtual Page Station provides individual Zone selections, Group Zone selections, and Snapshot Zone Selections.
You can automate the Virtual Page Station by a Lua script, or External Control. You select theMode (Live, Auto,
Delay, andMessage), the Priority, the Preamble directory and file, and theMessage directory and file.
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This release of Q-Sys designer deprecates the Virtual Page Station that was available in release 2.0. Q-Sys
Designer release 2.1 supports the old Virtual Page Station, but you cannot addmore release 2.0 Virtual Page
Stations in release 2.1.

Control Script Component
The Control Script editor now occupies an entire tabbed page. The default name of the Tab is "Control Script". If
you select the component in the Q-Sys Designer Schematic and type a new name, the Tab namewould read, for
example, "MyScript : Control Script".

NewandChanged Features in Q-Sys Designer
Configurator
If you attempt to close Q-Sys Designer when there are unsaved changes in the Configurator, you receive a
warning message.

Connection Status Bar
The Connection Status bar now shows the Core name that displays the status message and all available IP
Addresses when you hover over the namewith your mouse pointer.

Controls
The following new features apply to controls copied from aComponent's Control Panel into the Schematic.

l A control's identity can be reassigned by dragging one control over another

l A control's style can be copied to another control by dragging one control over another

l Button Style "Custom" has been changed to "String", which better reflects its use

l Meter background color property has been added

l You can now use special characters to change the value of a control. You can drag a control into the
Schematic, and change theStyle of the control toButton, then change theButton Style toString, and enter
one of the special characters. When you click the button, the associated control changes based on theString.
In addition, you can select a control, in the Schematic or a Control Panel, and simply type in one of the special
characters to change the value of the control.

Special Character What you would key in. Change to Control Value

++ ++ up one unit

-- -- down one unit

+= +=5 up five units

-= -=7 down seven units

*= *=2 multiplies the current value by two
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Special Character What you would key in. Change to Control Value

max max places control at its maximum value

min min places control at its minimum value

l New "text field style" for text field control

o Normal

o Meter Background

o NoBackground

External Control
New External Control commands are available to support Metadata (Control coloring, hiding, disabling,
combo box choices).

You can now ramp controls via external control.

Graphic Tools
The Polygon now supports String Button Style andOff Color. These are set in the Properties of the Polygon once it
is in the Schematic.

HoverMon
Q-Sys Designer no longer displays HoverMon text for controls that have no pertinent information to display. For
example, momentary and trigger type buttons.

Installation
During the installation of Q-Sys Designer 2.1, the storage drive on the Core will be re-partitioned to allow room for
new system files. If you havemedia files stored on the Core, Q-Sys automatically copies them to your PC then
copies them back to the storage drive on the Core. If there is not enough disk space to re-partition the drive and
copy the files back, you receive a warning before the process starts. If you do not have a backup of your media
files, contact Q-Sys Support before starting the upgrade.

When you install Q-Sys Designer, there are fewer steps required to complete the process.

Lua Scripting
The topic, Using Lua in Q-Sys, has a new organization for easier use.

The Log.Message and Log.Error commands are now available.

A TCP/IP Socket server is now available for Lua scripts.

Named Controls
The NamedControl list now allows you to sort by name and group by component. Both are case-insensitive.
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When pasting components that have NamedControls, Q-Sys Designer now asks if you want to create new
NamedControls for the pasted component.

Networking
Q-Sys 2.1 adds the Cisco Small Business 300 Series Ethernet switches to the list of Q-Sys Qualified Switches.

Linksys SLM Series Smart Switches and SRW Series Managed Switches are End of Life (EoL)
by the manufacturer.

Online Help
TheQ-Sys Help file is available from theWindows Start Menu under Q-Sys Designer. This link takes you to the
QSC website to ensure you have access to the latest help.

Preferences
A new Preferences selection under File on themainmenu is now available. In the Preferences dialog, you can:

l Management the Hard Links for remote access to a Core, or UCI.

l Under AudioMonitor, you can Enable audiomonitoring (HoverMon), select the Driver, and Test your setup.

Q-LAN Transmitter and Receiver
When streaming audio between Cores, youmust set the Clock Domain of both Cores to Custom in the Core's
Properties. If not, and you have aQ-LAN Transmitter and/or a Q-LAN Receiver in the design, Q-Sys displays an
error indicating the Clock Domain setting is not correct.

Remote Access
Q-Sys Designer 2.1 changes the location for the Hard Links file. The new location (and file) is now the same as the
UCI Viewer:

l Windows 7 – C:\Users\<username>\AppData\Roaming\QSC Audio\hardlink.xml

l Windows Vista – C:\Users\<username>\AppData\Roaming\QSC Audio\hardlink.xml

l Windows XP –C:\Documents and Settings\<username>\Local Settings\Application Data\QSC
Audio\hardlink.xml

NOTE: You can now manage your Hard Links for both the UCI Viewer and the Core using the new Preferences
dialog (from theMainmenu, File > Preferences > Hard Links).

Right-Click Feature
You can now duplicate an item in the Schematic by right clicking it and selecting Duplicate from themenu.

Schematic Pages
When you open a design, Q-Sys Designer recalls which Schematic Pages were open the last time you opened the
file, based on the name of the file. If you open a file with the same name but in a different location on your
computer, Q-Sys Designer recalls the pages from the previous file, not the one in the new location.
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When you rename a Schematic Page, Q-Sys Designer sorts the renamed pages alpha-numerically in the left-hand
pane.

NewandChanged Features in Q-Sys Administrator
Page Station Settings
You can now select the Revert Selected Command (the action taken by the Page Station after a page, or a
timeout) and the timeout for a Page Station.

PA Zones
You can now filter the PA Zones and User views with the use of tags.

Audio Files
You can create Playlists in Q-Sys Administrator that will persist in the design. For more information on how to use
Playlists, refer to the Audio Player.

You can now view the free space available, for audio files, at the top of the Audio Files tab.

Q-Sys 2.1 provides new and improved Preamble files.

PA Global Settings
There are two new PA Global Settings:

l Queue Timeout – TheQueue Timeout provides amechanism to discard hindered (due to busy zones) Play
Message Commands or Delayed Page Commands.

l Cancel Delay – Wait this much time after issuing a Play Message Command to allow canceling before the
message is queued for playback.

Event Logging
Q-Sys Designer purges the Event Log when the file reaches 10MB, or is stored for 31 days. Q-Sys Designer
deletes one day at a time until the log is under 10MB, and nothing is older than 31 days.

Q-Sys Designer now logs the following Events:

l Connect – Now includes connections through External Control, but not Q-Sys Designer, or UCI connections.

l System –Now includes changes to the SystemMute.

l Paging – Now includes changes to the Paging configuration.

Interface
The design name and theQ-Sys Administrator software version are now included in the title bar of the stand-alone
Administrator. When you run the Administrator, be sure it is the same software version as the Q-Sys design you
want to access.
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NewandChanged Features in the Q-Sys UCI Viewer
Controls
The UCI Browser panel now has a show/hide button. This button takes the place of grabbing the edge of the
Browser panel and sliding it to the left in order to hide it.

The UCI Viewer now has a Touch Screen Control Mode button – In Touch Screen Control Mode, the cursor,
hovering, and text entry are disabled, and a logon pin-pad designed for a touch screen is available for login. (In
normal mode, a dialog box is available for logon.)

Controls
If the Q-Sys UCI Viewer resides on the same PC as Q-Sys Designer, you can use the new Preferences dialog to
manage Hard Links (from theQ-Sys Designer Mainmenu, File > Preferences > Hard Links).

Miscellaneous
TheQ-Sys UCI Viewer now displays the UCI Viewer's software version in the title bar.

NewandChanged Features in iOSUCI Viewer (BETA)
To download the Q-Sys Apple iOS App, go to http://itunes.apple.com/us/app/q-sys-
control/id417461920?mt=8&ls=1.

Remote Access ability added using Hard Links.

iOS UCI Viewer now supports redundant Cores (auto switches to active Core)

iOS UCI Viewer can now connect to Cores via their Aux LAN ports

NewandChanged Required Software
The following software is no longer required for Q-Sys Designer as of release 2.0:

l Adobe AIR – No longer supported. (For existing UCIs that use AIR, use the Q-Sys UCI Viewer.)

l Adobe Flash

Q-Sys Designer 2.1 does not support the following software; however, it is required for upgrading from Q-Sys
Designer 1.0 or 1.1 to Q-Sys 2.1.

IMPORTANT: Youmust upgrade to Q-Sys Designer 2.0 prior to upgrading to Q-Sys Designer 2.1.

l Apple Bonjour forWindows

BETAVersion Features
There are a number of features in Q-Sys Designer currently in a BETA version. These features aremarked as such
in the Q-Sys Designer user interface, and in the associated help topics. A feature labeled as BETA indicates that
the feature is not as polished as wewould like it to be. It is functional, but theremight be caveats and rough edges
associated with it. In addition, a BETA feature is more likely to change in the future.
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Currently in BETA
l Channel Group

l All Effects components Auto-Pan, Chorus, Doppler, Echo, Flanger, Tremolo

l StandardMic/Line In card (Type 2 hardware)

l CobraNet Card (Type 2 hardware)

Removed from BETA
l FIR Custom Filter

l Q-Sys Touch Screen TSC-8

Resolved Known Issues
PA Router BGM Assign Buttons do not Work when Zone Count * BGM Input is Above 4096
(64 * 64).
Issue:When the product of PA Zones * BGM Inputs is greater than 4K (64*64), the BGM source select crosspoint
buttons were not functional.

The crosspoint buttons are functional up to themaximum PA Zones * BGM Inputs (256 * 64), or 16K.

Amplifier Occasionally Misidentified when Switching between Redundant I/O Frames with the
DAB-801 Automatic Mode Button OFF, and a Manual Backup Engage Button ON
Issue:When using a DAB-801 in the following scenario:

l redundant I/O Frames,

l in the DAB-801 control panel, the Automatic Mode button OFF and

l one of theManual Backup Engage buttons ON and

l switch from the active I/O Frame to the standby I/O Frame

Q-Sys occasionally misidentifies the type of the amplifier:

l The Status in amplifier’s control panel displays "Fault –Wrong Type".

l Additionally, if a 4-channel amplifier is identified as a 2-channel amplifier, the Status display will include
"Channel 3 disconnected, Channel 4 disconnected".

4-Channel Amplifier Occasionally Loses Channels 3 and 4 when Switching between
Redundant I/O Frames with the DAB-801 Automatic Mode button OFF, and a Manual Backup
Engage Button ON
Issue: If you have, a 4-Channel amplifier connected to a DAB-801, and switch from the active I/O Frame to the
standby I/O Frame, with the Automatic Mode button OFF, and aManual Backup Engage button ON, Q-Sys



Q-Sys Designer Release 2.1 Release Notes

Page 14 of 16 QSC Audio Products, LLC September 2011, Revision A

Designer identifies the amplifier correctly but channels 3 and 4 of the amplifier are occasionally lost. The status in
the amplifier's control panel displays "Fault - Channel 3 disconnected, Channel 4 disconnected".

Uploading Large Audio Files Occasionally Fails
Issue:Occasionally when you try to upload a large audio file to the Core, the process will stop without uploading the
file or giving an indication that the process stopped, other than the progress bar isn't moving.

Cannot Preview Audio Files in Sub-directories of the Messages and Preambles Directories
Issue: If you create a sub-directory under either theMessages or Preambles directory under the Audio Files tab, and
upload either .wav or .mp3 files into those sub-directories, then attempt to preview one of those files by clicking the
play button next to the file, no audio is produced.

Cannot Access Audio Files in Sub-directories of the Messages and Preambles Directories
Issue: If you create a sub-directory under either theMessages or Preambles directory under the Audio Files tab, and
upload either .wav or .mp3 files into those sub-directories, then attempt to use those files in any commands, the
files do not display in the list of available files.

Known Issues

Q-Sys Designer Interface

cgi-bin/status_xml Error when Deploying
Issue:Rarely, when deploying a design to the Core, Q-Sys Designer may idle for a few minutes with a "Discovering
Core..." message. Eventually, an error appears stating, “Error downloading file cgi-bin/status_xml…”

Workaround:Clear the error message by clicking ‘OK’, then wait 5 minutes and deploy the design again.

Lua Script Code Written with the Control Script Component in, or dragged into, a Channel
Group Component, is Hidden/Deleted when you Emulate or Run the Design.
Issue:Q-Sys Designer hides Lua code, written in a Control Script, in the following circumstances

l Write the code in Design, Run, or Emulatemode, then go to Designmode (if not already there) and drag the
Control Script into the Channel Group and Emulate or Run the design.

l Drag the Control Script Component into the Channel Group, write the code in Designmode, then Emulate or
Run the design.

Q-Sys Designer deletes Lua code in the following circumstance.

l Write the code in one of the above circumstances, then Emulate or Run the design, and write somemore code
in the Control Script component. Go to the Designmode, only the code written while in themost recent
Emulate or Runmode is in the Control Script Component.

Workaround:Write all code with the Control Script component in the Channel Group, in Run or EmulateMode.
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DDI-11 does not Turn Red, in the Inventory List, to Indicate a Fault.
Issue: The DDI-11 does not indicate a fault, by turning red in the Inventory list, under any circumstances. Following
is a list of possible scenarios:

1. The DDI-11 is in the design and not connected to anything

2. The DDI-11 is in the design and connected to amalfunctioning or misidentified DataPort card, installed in a
Core or I/O Frame

3. The DDI-11 is in the design and connected to a DataPort card that is in an I/O Frame that is offline

Workaround: In scenarios 2 and 3, use the I/O Frame or DataPort card Status for the Fault indication. In scenario 1,
the only indication would be no audio output from the amplifier physically connected to the DDI-11.

I/O Frame with four AES3 Cards Exhibits Sluggish LCD and Configurator Response
Issue: An I/O Framewith four AES3 cards installed, and all inputs and outputs carrying signal, will display sluggish
LCD and Configurator response.

Context Find (Ctrl-F) Locks up when Specific Steps are Used on Inventory Items
Issue: The Context Find feature locks up under the following circumstances:

1. Select a component in the Inventory list, for example, an I/O Framewith components in the schematic

2. Press Ctrl-F, make sure the "Find By:" drop-down list has "Context" selected

3. Select one of the components in the "Find Results" list

4. Click your mouse somewhere in the schematic (not another component)

5. Press Ctrl-F (while the Find dialog box is still open)

6. Select a component in the Inventory list (with components in the Schematic)

7. Select an item in the "Find Results" list. The Find dialog box is frozen

Workaround: Avoid using these exact steps.

Preamble Gain in PA Page Commands does not Work
Issue:When you adjust the Gain control in a Page Command, it has no effect, even though the numbers on the
control increment, indicating a change.

Workaround:None

Control

Cannot Place Matrix Mixer banked Controls in Snapshot Banks
With Control Banking active in aMatrix Mixer, you are unable to drag any of the banked controls into a Snapshot
Bank. However, you can drag the wholemixer in, in which case the banked controls appear to work correctly in the
Snapshot Bank.
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Core Firmware

Inventory and Component Device Status Indicators do not Match
Issue:During the I/O Frame firmware update, and then during the restart of the I/O Frame, the I/O Frame
Component (e.g. Line Out card) status strings indicate "Missing - I/O Framemissing", while the Inventory status
string indicates other, varying states.

Loudspeaker Status is "OK" when the Amplifier has no Connections to Anything in
the Design
Issue:When you have loudspeakers connected to an amplifier in a Q-Sys design and the inputs to the amplifier
have no connections in the design, the loudspeaker Status reports "OK".

DSP

I/O Input Card Meters do not Work When no DSP is Wired to the I/O Input Component
Issue: If you have an I/O Input card (AES3, CobraNet, Mic/Line In) installed in an I/O Frame, with an audio source
connected to the inputs of the card, but nothing connected to the outputs in the design, themeters in the Control
Panel of the I/O Input card, do not work. All the other functions appear to work, for example Phantom Power. This
situation gives the impression that the input source is not working.

Windows Installer

Media Files are not Copied Back to the Core During the Upgrade Process
Issue:During the upgrade process to Q-Sys Designer 2.1, on Cores that do not have the SSD upgrade, themedia
files may not get copied back to the Core.

Workaround:

1. Start Q-Sys Designer
2. Load from Core and Connect to the upgraded Core
3. Start Q-Sys Administrator (or the standalone Administrator)
4. Select theAudio Files tab and select either theAudio,Messages, orPreambles subdirectory
5. Click the add file icon (plus sign) then navigate to (Windows XP –C:\Documents and

Settings\<username>\Local Settings\Temp\QSys Temp Files\Media or (Windows 7 –
C:\Users\<AccountName>\AppData\Local\Temp\QSys Temp Files).

NOTE: If this folder is not viewable inWindows Explorer, from theWindows Explorer menu select Tools >
Folder Options>View tabthen click theShow hidden files and folders radio button and click OK.

6. Select the files that belong in the directory, and click the Open button to upload the files.
7. Continue uploading the files for each directory.

NOTE: The Audio Files directories on the Core before the upgrade, are rebuilt; you do not have to recreate them. You
can upload the all the files from one directory at a time, but you cannot upload the folder itself.
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